Tips & Tricks to

mprove Efficiency,

Patient Management,
& Cash Flow

"Block & Biggs Road Show

" For copy of presentation go to:

http://blockandnation.com/blockandbiggs
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Who Are We?

"Bradley M. Block, M.D.

= Family Physician in independently owned, four physician Family
Medicine group in Oviedo, Florida

= eCW User for 11 years
=William “Reddy” Biggs, M.D.
= Endocrinologist in independently owned, thirty-three provider
Internal Medicine Multi-Specialty group in Amarillo, Texas
= eCW User for 9 years
= Board Certified in Clinical Informatics
= CPT reviewer for AMA
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Why Were We Asked to Speak?

=mBoth of us:

=Spoken together at NUC since 2008

= “eClini-Geeks” on the eCW Web User’s Forum for
assisting users w/ expert eCW advice
= Dr Block — written over 1,600 posts

= Dr Biggs — written over 3,000 posts & is a Forum Moderator

mBeta testers for new modules & versions of eCW
sAttested for EHR MU Bonus Stage 1 & 2: 2011 - 2014
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Goal of Our Talk Sp—l

Tm
sStreamline Your Office Workflow & Transform
Your Practice into a Modern Platform of

Patient Care by Maximizing Tools Available to
You

"| ots of New ldeas
"\ake Note of at least 3-5 Things Presented
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Why Bother to Implement Changes —
How Does This Benefit Me?

®"|ncrease
" |mprove

Ffficiency of Providers & Staff
Documentation for Future Reference

& Med M

Bz e

al Protection

Enrich Quality of Patient Care
mprove Patient Engagement

Patient Satisfaction

mSave Money & Boost Income
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Overview of Our Presentation

#Share Tips, Tricks & Examp

Front Office

les

Mid Office (Medical Providers) eCIinicalWorkS1

Back Office (Billing & Finances) f =
AN

mQuestion & Answer Sessio

ERCli

the End - Make notes so you don’t:

orget
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NS EE
Customize Your Daily Workflow in eCW
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Mid Office

mPatient Management & Charting
of the Past
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Mid Office

"Patient Care & Charting of the Future
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ICD 9 to ICD 10 Mapping Utility

=Converts codes well for Order Sets, eCliniSense,
and many other DX code containing functions

sRecommend AGAINST use for Templates

"Does not address Problem Lists, but patch for this
coming soon....

The purpose of this tool is to assist you in identifying all of the master files in your eClinicalWorks database that contain ICD-9
codes and to map them to the suggested corresponding ICD-10 codes using CMS's GEMS Mapping Crosswalk in the following
areas (*except for 'Superbills’ and 'Future Lab/DI Orders'):

¢ Templates

e Order Sets

» ICD Groups

¢ Superbills*

* Dx Alerts

¢ ICD-CPT Combinations
¢ eCliniSense

¢ ICD Manifestation Codes
¢ ICD Categories

¢ Future Lab/DI Orders*
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Conquer ICD 10 — Chart Like a Pro
- Maximize eCW Functionalities

"Fun with Favorites
" Tips for Templates
®Ogle over Order Sets

="\Wrangle with other
visit note work flows

~ ., -
L™
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Here a Favorite, There a Favorite,
Everywhere a Favorite

mJse “Favorites” to Save Time
(especially with ICD 10 transition)

mUsually triggered by clicking on the
Favorites “star” (which turns yellow)

=| abs, DI, Procedures, Immunizations,
Med HX, Surg HX, Letters, Visit Note
Sections & Categories

"Unique to Each Provider or Staff
"Examples & Configuration Options
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Use “Favorites” to Create Custom Lists

for Ordering Common Labs, DI, Procedures

(& Use Lab/DI Button to Toggle Between Screens)

| addveworder |
Lookup: [ -: [Ty | EXTYIYE vvpe: CEMIE # Otab 801  procedure

Lab Company: m g all ® previous Orders

Order Name Lab Companies
-CBC w Diff h/h,rbc,indc,whbc, w/ PLT Labcorp, Qu
-CMP (comprehe e metabolic pansl) w/GFR
-HEMOGLOBIN AL1C
-Lipid Panel (TChol,Trig, HDL,LDL) w/non-HDL-C
-PSA , serum (refrigerate)
-T4 Free (Thyroxing)
rroid Stimulating Hormene)
-Uric acid
-Wit D, 25-Hydroxy, Total (for deficiency)
-\itamin B 12

Lootcup: I - [T TN | EXEXIENE 1voe: NS &  ® Lab 901 ® procedure
DI Company: _ S All #® Previous Orders

Order Name Lab Companies

ME DENSITY of Hip, Lumbar Spine w/ FRAX S =) SimonMed Rad Bi, CDI_Rad_Bi
diogram

Mammo DIAGNOSTIC BILATERAL DIGITAL W/ BREAST US as needed
Mammo DIAGNOSTIC LEFT DIGITAL, W/ BREAST US ed Rad Bi, CDI_Rad_Bi
Mammo DIAGNOSTIC RIGHT DIGITAL, W/ BREAST U Med Rad Bi, CDI_Rad_Bi
Us ABDOMEN COMPLETE onMed Rad Bi, CDI_Rad_Bi
US BREAST- BILATERAL (& Axilla as needed) 3 ed Rad Bi, CDI_Rad_Bi
US BREAST-UNILATERAL - Left (& Axilla as needed) simonMed Rad Bi, CDI_Rad_Bi
US BREAST-UNILATERAL - Right (& Axilla as nee ; ed Rad Bi, CDI_Rad_Bi
¥Ray CHEST 2 VIEWS (PASLAT)
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Use “Favorites” to Create Custom List
for Ordering Frequently Used
Immunizations & Injections

im Immunizations;T.Injections

Imm Schedule|Flu Schedule

Delete

Find

Pneumococcal-23 (adult)™

Prevnar-13- Pneumococcal™
TDaP-Adacel/Boostrix-(11yrs & over)™*-Te
Zostavax - Shingles Vaccine**

[Refused Influenza Vaccine or Deferred t

[Refused Pneumovax Vaccine or Deferrec

eClinicalWorks

™ Alll % My Favorites

Find

B-12, 1000 MCG*
Kenalog per 10 mg™
Phenergan (to 50 mg)*
PPD*

Rocephin per 250 mg™

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Your Own Individual Custom List
of Favorite Labs, DI, Procedures

z- silimg Reports CCD Fax ePavment Tools Community Meaningful Use | Lock He

Alerts

"Go to EMR> Labs, DI,
Procedures> My Labs,

Jiagnoskic Imaging

DI, Procedures Favorites [l

Inst

=Use “Add” Button in
each Category to Create

mprehensive metabolic panel) w/GFR
LOBIN A1C
-Lipid Panel (T rig, HDL, LOL) w/fnon-HD
-PSA , serum (]
-T4 Free (Thyr
-T5H (Thyroid Stimulating Hormone)
-Uric acid

o o o o o o o

-\fitamin B 12 Quest, Labx
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Use “Configure Categories”
to Create Custom Lists of Favorites
for Multiple Providers or Staff at Once!

=Go to EMR> Miscellaneous ®Labs, DI, Procedures,
Configuration Options> Immunizations, Injections
Configure Categories>

Lab Orders, etc.

- Biling Reports CCD Fax ePayment Tools Commuonity  Meaningful Use | Lock Help [~ all Catedgln E
|- 55505 Surg Path-1st

@ all Licensed Providers (" all Other Staff

Alerts

Immunizations) Therapeutic Injections
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Update Patient Charts Faster by Customizing Your
Own “Favorite” Medical & Surgical HX Items

=Click on Star next to
Med or Surgical HX Item
to Add to Favorites List
(turns yellow once added)

=Click on Star next to
Search (“Find”) Box to
see Only Favorites

="Unique to Each User

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Find & Run “Letters” Quickly —
Create Your Own “Favorite” Letters List

i, Letter Templates

mClick on Star next to
Letter to Add to ST -
Favorites List

turns yellow once added

=Click on Star next to
Search (“Find”) Box to B
see Only Favorites

=Unique to Each User

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Reduce Clutter in Visit Notes — Create
Customized View of Your Favorite Categories

Pt.Info Encounter Physical 1: Hub Pt.Infe Encounter Physical 1: Hub

mSearch through Visit omrelims i e o me el Bms K R
Note Sections FASTER [z - endocrinolooy/ T Endocrinology/

- Subjective
=\Works in HPI, ROS, Srim sy (a
Exam, PE, Assessments | it 4|2 cricormalos

- *Echocardiogram({,
- Medicare Annual

& P roced U re N Otes -- Patient Care Team

+- Allergy/&sthma

= Great for Multi- ' BEFORE AF

- Dermatology

S peCIa |ty G ro u p +- Endocrinclogy

- ENT/respiratory
+]- Infectious Disease

u Ca n n Ot \/i eW Catego rl eS +- Male Reproductive Denies All | Clear A

- Diet/Exercise Denies All | Clear A
Motes | Header

1 +- Musculoskeletal
removed from view i Musculoskeletal| otes [ Heade
- Nephrology -

w/o changing settings [IREs ;

L | Vitals | Mew v|

[uestionnaire l

4 I k

1 Vitals | Mew "|
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Use “Configure Categories”
to Customize Sections for Providers & Staff

"Go to EMR> Miscellaneous g
Configuration Options> F—
Configure Categories> =

Filter By |_|::Eer' hd l

Block Bradley M

HPI, PE, Assessments, etc.

-B_illing Reports CCD Fax ePayment Tools Community Meaningful Use | Lock Help

Alerts

Imrnunizations) Therapeutic Injections
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Templates 101

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Why Use Templates Instead of Order Sets?

. Copy And Merge Templates

=sTemplates Provide
Documentation in Any
Section of Note

=Order Sets ONLY Can
Provide & Insert TX Plans

sTemplates Allow for
Customized Insertion
through “Options” Screen

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy”




Avoid Merging in Unwanted Template Data
by Setting Default Template Options

B9 Default Options for Block, Elrad...

Defaults For |Template

Copy And Merge from Templates ...
ds Template ...

Templates List ...

Set Default Options
Templates ||J|| Claim [I] Letters [I] Ink || |

Cancel

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Templates Easily on The Fly

DERMATOLOGY
in without rask ithout jaundice.

Assessment:
Assessment: -
& Sinusitis, Acute, NOS - 461.9 (Primary)

Plan:

Acute, NOS
Start Phenergan

if problem worser

Procedures: opy And & From Template
Save Motes As Template ...

. Save Notes As Template
Associated Order Sets

Diabetes and Renal
Description
Hypertension and CHF

Thyroid Disorders

well PE

Ankle, Foot, and Leg
Sprain

Allergies, Asthma, COPD

Back, Neck, and
Radicular Pain
Shoulder, Elbow, and
Wrist Pain

) T hd
Category
-

ACCEess

Hip and Knee Pain

Lipids and CAD

(oo ooooooon

Save As Default

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Order Sets
- Just What the Doctor Ordered...

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Why Use Order Sets Instead of Templates?

| Te m p | ates O n |y LI n k TX ORDER SET: Diabetes and Renal

DIAGNOSES (TRIGGER):

Plans to Single DX Code & [

cla

. . . 0 MNephritis NOS in -_:uther disease ORDER SET: Anemia and CB(
Limit TX Plan Choices

. DIAGNOSES (TRIGGER):
sidney disease, stage 1

dney ild) 050.0

" Order Sets can be linked to rric idney ieace, cage 3 () T

dney disease, s 4(s I 54, Anemia, unsp

Numerous Codes (i.e.- >80 brric kv diense repech et e o st

Type 1 diabetes mellitus with ketoacidosis - , Long term t) use of

10 without coma "= antithrom ntiplatelets
D I\/I & Re n a | COd eS) 0. Type 1 diabetes mellitus with ketoacidosis wi - f

coma

iency anemia secondary to blood loss

Type 1 diabetes mellitus with diabetic

mOS’s link unrelated Medical s 1,120 Wethylmaloic acidems

Type 1 diabetes mellitus with diabe ronic Folate deficiency anemia, unspecified
kidney d e - .
0 Hereditary hemoc

Conditions which share 25 Type 1 disbates melivus with other disberic  f 0% O EE

Type 1 diabetes mellitus with unspecified D7 Other neutropenia

Q a 0 ' diabetic retinopathy with macular edema E Other specified nutritional deficiencies
SI m I | a r te St O rd e rS ( I . e o 1 6 Type 1 diabetes mellitus with uns ; Vitamin deficiency, unspecified
- athy t macular edema
V4 vpe etes mellitus ile
DX’s related to Hematology [EEtrssngisaumms
macular edema
Type 1 diabetes melli ith mild

& \/ita m i n i SS u eS ) nonproliferative diabetic retinopathy without

macular edema

ith mode
etinopathy
macular edema

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Update All Order Sets
to ICD 10 Quick & Easy

mUse ICD9-ICD10 Mapping Utility to

“Replace” all codes in Order Set tab

Order Sets ICD-9 Association

] se6.911a
[¥] sg3.501A
Elbow, and Trigger §42.00 Spraiglgi'.'.'rist P % z
o ) - -

(3l
Shoulder, T ¥ m77.12
Ellju;m\lf al_'ld Trigger 726.32 El:li-:?':-l':;'j‘iiﬁ::% [¥] m77.10
Wrist Pain  M77.01 No Change
T Append
shoulder, odia I mz7.00
E!"ri'"t F.::.Id Trigger ' epicondylitis E M77.01
o [ m77.02
J
Shoulder, Adhesive | —/C] M75.01
Elbow, and Trigger 6. capsul [ M7s.02 || Mo Change |
Wrist Pain shoulder D T

Shoulder,

! o Joint pain, I
Elbow, and Trigger 719.41 e Mo Change | 3

Bradley M. M.D. -- William “Reddy” Biggs, M.D.




Wirodut
h, O company g

eClinicalWorks

Order Sets — Quickly Create TX Plan

Hypertension, Benign Atrial Fibrillation Hypothyroidism, Unspecified Hyperlipidemia Asthma, Unspecified wio Statu
[ Order || Browse |

% =ynthroid (0.05 mg) 1 tab(s) Q am o v 30 day(s rally /25/2011 [OterActions 7] M

?% | evothyroxine 100 meg (0.1 mg) 1 tab in AM once a day 50 day(s) orally IO‘Lherr‘{:tionS Vl H

e

T o e
-TSH (Thyroid Stimulating Hormone) Quest, Labcorp,CPL - 09/01/2014 W H
hyroxine) Quest, La o = /201 lm H
odothyronine) Quest, Labcorp,CPL - lm H
TPO) Quest, Labearp,C : 5/2015 [Otner Actions =] M
-Thyreid Antithyroglebulin Ab Quest, Labcorp,CPL = lm H
~CALCITONIN LEVEL (frozen) Quest, Labcorp,CPL [Ctner Acions =] 1

‘I‘I‘I‘I‘I‘IIE m| &

Diagnostic Imaging AssignedTao: | Biock, Bradiey M _
P — e mmm-
[ & US NECK/THYROID/PARATHYROID SimonMed Rad B 07/06/20 IOtherﬁctlons H
O
O

Fine Meedle Aspiration (FNA) Biopsy of Thyroid Nodule or Mass SimonMed Rad Bi IOtherﬁ{:T.ionS - H

zMNuclear Thyroid Scan ID‘LherP{:T.IOnS - H

Assigneros [ 5% 5355 1 “order || Browse
. S T R S NN

Im | | Dose | oDate |swtws ] .. [  Mame | |

Appointments ﬁ Referrals

Physician Education Patient Education

PDF PDF

WEB REFERENCE WEB REFERENCE

Notes

- Counseling done on probable etiolegies, potential testing, & potential treatment options., .Counseling dene on risks/benifits/ advantages of patient's therapies & treatment optiens., call if hyperthyroid symptoms, callif hypothyroid symgtoms

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.



v10: Use Order Sets for “Future” Orders

#Create Future Lab (or DI) Orders in Order
Set Administration Screen w/ desired

timeline & desired repetition

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Templates & Order Sets
Don’t Solve Everything
— Try eCliniSense for Everything Else

eCliniSense

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Import ICD 9 eCliniSense Data into ICD

10 Codes Quick & Easy

=Jse ICD9-ICD10 Mapping Utility to “Append”
all codes in eCliniSense tab

m3 sections — RX HX, Labs/DI, TX Notes

Diabetzs mellitus
type 1 with EI0.65 | =]
ketoacidosis, Ei0.10 Ppe
uncontrolled -

Diabetes mellitus |- [¥] £13.00
type 2 with T £4n

250.20 hyperosmolarity, E13.01 Append E

not stated as E11.00
uncontrolled

Rx History for eClinisense Lab/DI History for eClinisense

Migrated
{Append)

eClinicalWorks Bradley M. Block, M.D. -- W|Il|am “Reddy” Biggs, M.D.




Customize Treatment Plans with eCliniSense

&, eClinisense

.Great for |CD 10 & for lent Specific: ast Date: 2012-04-02 11:35:23.0
Less Common DX’s BE

="Can Jump from one DX to
Another (using Assess. Pull Down)

=" Order DX Specific Scripts,
Labs, DI, & Treatment
Notes

=Pull Up Choices by Any
Provider

= Patient Specific Option
(for exact code match: ICD10#9)

= “Generate” to Update
Choices (icp1029)

ding druag

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




“Orders” Screen Helps
to Overcome ICD 10

Medical Summany | Alerts | Labs | BT | Procedures | Growth Chart | Imm

Primary [nEuran-:F_*C

32807

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




vio: Try the New “Orders” Screen
to Edit Visit Treatment Notes

"Quickly scrol
through
Assessments list to
find ones missing

notes or to
update/edit TX
“Notes” or “Clinical
Notes”

="Pen |con opens up
TX notes screen w/
Browse button

eClinicalWorks

Medical Summary | Alerts | Labs | DI | Procedures | Growth Chart | Imm/T.Inj | Encounters | Patient Docs || Flowshee

Quick Search

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




vio: Try the New “ICD-Order Mapping”
Screen to Edit DX Links

=Quickly edit links
between test orders or
meds to DX codes with T
all items in  |[——m—

Add Dx Manage Crders

.
O n e | a rge g r I d 250.40 Diabetes mellitus type 2 wirenal manif

Re Januvia 100 mg tablet 1 tab for diabetes

] 272.4
hea | Hyperlipidemi

i
ncontrol

~

-

-

-

-

-

-

-

F

~

=CPT-ICD Association tab |jssss
& grid provides same
type of grid for linking
billing codes

DIPSTICK {IN OFFICE)

q @ A
970 a0 aananann

g 0707 = 77 7 0 a ananan«an

O 7 1 O O a0 nan
L A (e A R O I DA IR A A A A |

A
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But Wait — We Still Need More Remedies
For Managing Patients

=Simplify & Streamline
Scripts
=Play with Portal

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Speed Up Scripts —
Customize Your Prescription Workflow

5]

Prescriptions

8]

e
ePrescriptions

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Custom Scripts for Commonly
Prescribed Meds to Avoid RX Edit Time

=Chronic Medical Conditions (DM, HTN, OA), Antibiotics,
Pain & HA Meds

"|nstructions, Medical Indication, Typical Quantity

Dispensed & Refills

Add New Rx add Mew Order
R«
Type | CustomBx

Find |NEIIg=E4=l

F | Drug Marne| Strength
Y s 00 mag tablet

'. - Maproxen 375 mg

(7 Maproxen 500 mig

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize RX Edit Screen Pic Lists

Formulation

Crean
drops

qel

inhaler
liquid

nasal spray
ointment
solution
spray

-

Take
1 tab at bediime
1 tab every AM
1 tab every PM
1 tab for BP
1 tab for Cholests

1tab(s)
11isp
1-2 caps

1-2 pills as direct{y

o

Route
intravaginally

intravenage by

orally OTC
orally with food ]

TECiany
subcutaneously
sublingual
topically

fopically to affecte

-

Frequency

1iime a week
2times a week

as directed

at H/& onset May repeat

o
=) | B

Daaily as dir
once a day

once daily

Q 4-6 hours PRN
Cam

Duration
1 dose -
10 days
100 days
100 days &
14 days
15 days
180 days

20 days

200 days
-

" Dosage Calculator

Dizpense
100 -
120
180
20
28
3 Inhalers
3 Vials

30 grams

Refill

=

o [
fod == £

30 mL [+

[=r I =

100 mg ¥ ©|tablet &|1 tab for Diab = = |orally @ Jonce a day v fo\Bodays </ 4f30 7

* Combined length of Take, Route and Frequency cannot exceed 132 characters. [Remaining Characters 98).
¥ Custom Dosages are not shown by default. To Show/Hide Custom Dosages Setting follow the link:
MySetting --> Show/Hide Tab --> Custom Dosages in Rx Edit Screen

Rx: Januvia 100 mg tablet, TAKE: 1 tab for Diabetes, orally once a day, for 30 days, DISPENSE: 30, REFILLS: 3

| Apply || Cancel |

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Customize the RX HX Screen

+ Summary of: Septra DS 800 mg- 160 mg tablet

+ Summary of: Skelaxin 800 mg from ER tablet

+ Summary of: Sterapred DS 6 day pack 10 mg - 6 day pack tablet Mﬂdern Ulew
+ Summary of: Synthroid 38 mcg (0.028 mg) Brand Medically Necessary

+ Summary of: Synthroid 50 mcg (0.05 mg) Brand Medically Necessary

i, Select Medication

/7 Cur R~ R ByDate & RxByName, eRxRefil Synthroid Classic View

Phenergan with Codeine ;l | | | | | | | |

Prednisone 02/04/2 Refill 125 meg [ Brand Me 1 tabgan orally once ad: A0 days 90 Block Bra |
Propecia 1220842 Increaze 125 mog [ tablet 1 tab g an arally once ad:s 30 day:  Samples Block Bra |
Proscar 03/07/2 Increaze 112 mog [ tablet 1 tab g an arally once ad: A0 days 90 Block Bra |
Research-fsthma Anti-TSLP 19 maon 05/24/2 Refil 100 mcg [ Brand Me 1 tab G A1 arally once ads 90 dayps & 30 Block Bra |
Simwvastatin 02/09/2 Increaze 100 mcg [ Brand ke 1 tab O Al arally once ad:z A0days 90 Block Bra |
Singulair 1072742 Refil 88 mca [0 Brand Me 1 tab O Al orally once ad:z A0days 90 Block Bra |
Sterapred DS 12 day pack 03/14/2 Increaze 83 mecg [0 Brand ke 1 tablz)  orally once ad:z A0 days 30 Block Bra |
Sterapred DS 6 day pack 03/24/2 Increaze 7B meg [0 Brand ke 1 tablz)  orally [J am 90 day= & 90 Block Bra |
Syrmbicort 111942 Start B0 rmcg (0 Brand Me 1 tablz)  orally [ am 30 day(z] 30 2008-11-1 Block Bra
S ynthroid

Valtrex
Valtre:x Zelect All Select All (Mo DDR} Clear all Show External Bx | oK I Cancel |

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Converting the RX HX Screen
to Classic View

: .
1GGO to File> Settings> e -

MyProwders | UserSettings |  Physician Refarence | Views. |

Left Panel [cons " Modern View © Clasac View

My Settings> Views [ e Fae e

R List Yiew for Print and Fas o ModernView T Classic View
Alerts " D55 = Classc plerts [ Both
Manage Rx Modern Wiew 1 Classic View

Fhlaniaces = = = R Edit Modern Yiew 1 Classic View

Aftorneys

e Patient Labs, DI and Procedure Hix Modern View 1 Classic View

Tnsurance Groups k, Bradley M 2 Cumulative Lab Report Modern View  ( Clagsic View

Case Managers

0 | [ Modern View % Clacsic View

Lab Companies Formulary Rx Screen
Guaaicrs Irnmvunization and Flu Schedule Modern View T Classic View
Modern Wiew  © Classic View

Provider Mumbers
N Lab/DI/Procedure Drder Screen
Referring Physicians/Insurances Device DI Soreen M"ﬁ View [ Clagsic View

Refresh Counts

ule EMR Eiling

G e e |

%

e N e

Mandatory Fields

Facilities

Progress Nobes popup Screens

Farility Groups [I

User Groups Apply Medication Summary Modern View in ™ Currert Medications (Progress Nobes)
Templates P
PO I Current Madcations (ManagaR: - Moden View)
Zip Codes ) Prwmﬁbttiﬂﬁ Panel
FTe ™ Ra History (Patient Hub)
Reconcile Interface Resuls
™ Telephone Encounter

Facilities Additional Information

Interface Dashboard

Eruriby Sebtinn.

P BN WE s D WBR WT L WM Wa cC

Settings Primary Practice

Merge Patient Local Settings

Zhange Password My Settings
——

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Take Control of
Controlled Substances in Your Life

=Kick the Habit —
Stop Faxing & Printing Scripts

-Use EPCS -

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




e-Prescription of Controlled Substances

uElectronically Transmit All Schedule levels of
Controlled Substances in all 50 States

"Includes Meds for Pain, Coughing, Anxiety,
Sleep, ADD, Testosterone Replacement
= Oxycodone, Codeine, Xanax, Ambien, Ritalin, AndroGel

"Allows for Electronic Refills of ePrescription
Refill Requests

"\ost Pharmacy Chains including Mail Orders

"may have to educate some pharmacists....
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EPCS Tips

mRegistration & ldentity
Verification Process

= Allow ample time

= Have personal Credit Bureau Info
details handy —i.e.- mortgage &
auto loan payments

=\Watch for Pharmacy EPCS

enabled symbol

BCannot Transmit

Custom Drugs — Watch for
Multum or Medispan W4

"Create Order Sets, Templates
or Favorites w/ drugs pre-
§ configured for easy use

im. ePrescribe Rx

Patient Name Test, adiel &

Patient Address
871172009

Last Appt:
Next Appt:

0172172015 06:45 PM
Provider [
Provider Mame Black, Bradley

Pharmacy MALGREENS
.

Pharmacy Address |7403 ALOMA AVE,
WINTER PARK FL-32792
Phone: 407-677-5554

Set as primary
r Pharmacy

Motes to Pharmacist

Supervising Provider Black Bradley M

Prescription
Mew & Refilled Prescriptions

"
v Start Adderall
W =tart acetaminophen-hydrocodone
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Future Refills of Schedule Il Drugs

®Can use calendar function to transmit multiple
pre-dated scripts on meds which prohibit refills
" No more monthly calls to print out scripts

=" No need to print out copies of pre-dated scripts

=Only place to see multiple refills is in e-RX Logs (& still don’t see
the future dates) - Consider Note in Chart such as:

m script(s) ELECTRONICALLY TRANSMITTED for 4 SETS OF MONTHLY REFILLS on
their ADD med WITH PREDATED SCRIPTS d/rect/y to the pharmacy

09/19/2015
5

8 9| 10| 11| 12 13| 14

15| 16 17 18 1-21
Login Passwor. d [eesee Your Six Digits otp: 123456 | 55 23 24 25 26 27

29 30
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Save Even More Time —
Stop Fax Refill Requests from Pharmacies

: Your Name Hf.zr.e MD
Fax refill requests lower e
efficiency & productivity Amarilo, Texas 79106

I I EAR PHARMACY:
Insist pharmacies only P ‘
Due to the recent marked increase in the number of computer generated fax requests from

S u b m it refi | | re q u e StS vour company, we will no longer respond to them.
e | e Ct ro n i Ca | y [ have found many of them to be requesting medidnes that are no longer on the patient’s

current medicine list.
WO r kS fo r a | m a 1 O r Th erefore, please have the patient request a refill from us at the time of ther next

J office visit, and we can discuss it with them at that time_ K they need a refill prior to their
mext visit, they can come by our office or have the prescripti on mailed to them at no

p h a r m a Cy C ’] a i n S a n d m O St charge; or faxed for anominal charge.

1 1 Alternatively, wewill r dtorefill r hat vou initiate via SureScripts.
mail order & independent  seriiiarisrim e —
| O C a | p h a r m a C i e S We hope that you share our goals of encouraging our patients to be fully involved in their

medical ded sions, and therefore enhandng the quality of their medical care.

\NO R D ve rS i O n Of Lette r In th e future, please do not fax refill requests to us, as we will not bereplyingto them .

Please contact the patient and request they discuss their wfill s with us at their next visit.

on our Web Site

Jane Smith, MD FACP
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Stop Pharmacy Faxes Efficiently
- Simplify the Process

mCreate eCW “Letter”
from WORD h FAMI-LYJMICIJE

Document e

®INC | U d - ta g fO r NOTICE THAT WE WILL NOT RESPOND TO FAXED REFILL REQUESTS

Patient’s Name &
DOB

Due to the recent marked increase in the number of computer generated fax requests from

m % u n & F a X t h e all pharmacies, we will no longer respond to them.
We have found many of them to be requesting medicines that are no longer on the patient’s
(o P h a r m a C F a X current medicine list.
y Effective immediately, our office will respond only to refill requests that you initiate
< 7! electronically via SureScripts, since this allows us to review the patient chart with the
O I Cy e e r ro I I I request, and to respond to your request in a timely manner.
. a t i e n t ’S C h a rt In the future, please do not fax refill requests to us, as we will not be r ing
Section]/ *agel s Linel Call MUK - e
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vio: Update Current Med List
the Easy Way from External RX HX

iyl | External Rx History Add Medic ation Y | [ Verified [~ Rx Name Only

Cancel

Date- 09/02/2014 Source: BLOCK BRADLEY Qty: T0 Mutually Defined Duration: 5

%: FLUCONAZOLE 150 MG TABLET (08/29/2014)

Date: 08/29/2014 Source: CHASE CRAIG Qty: 1 Mutually Defined Duration:

—) RALOXIFENE HCL 60 MG TABLET (D8/18/2014)

Date: 08/18/2014 Source: BLOCK BRADLEY Qty: 90 Mutually Defined Duration:

(—) CEPHALEXIN 500 MG CAPSULE (08/15/2014)

Date: 08/15/2014 Source: SCHULZE RAFAEL Oty: 14 Mutually Defined Duration:

(=) LINZESS 145 MCG CAPSULE (08/15/2014)
Date- 08/15/2014 Source: BLOCK BRADLEY Qty: 90 Mutually Defined Duration:

Date: 06/04/2014 Source: BLOCK BRADLEY Qty: 90 Mutually Defined Duration:

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Customize Vacation Coverage Workflow —
Refill e-scripts for Partners Quick & Easy via
“Assign Refill RX” (or reassign scripts received in error)

= Staff can assign refills to covering provider

= Caution — RX does not disappear from 1%t doc’s list until
addressed by 2" doc

i, ePrescribe Rx

Patient Name

Patient Address

DOBE : 1954-10-31 I

Last Appt: 02/24/2015 03:00 PM
Next Appt:

Assign Refill To
Provider Name

Black, Bradley M f~ s si

Pharmacy .

Pharmacy Addre

Notes to Pharmacist

o Medication
Drug Marie WALSARTAN/HCTZ YALSARTAMNHCT,
Formulation Tablet Tablet

eClinicalWorks Bradley M. Block M D -- William “Reddy” Biggs, M.D.




Keep Connected with Patients —
Use the Portal to Customize
Patient Engagement

ﬁ
j‘._| O password

Pre-Register Forgot Password?

Amarillo Medical Mobile App
Specialists LLP

Your health is in
Welcome to Amarillo Medical Specialists! As part of your hands. ..
your 'medical home' our web portal facilitates i
better communication with our doctors by Wlth healOW '
providing convenient 24 x 7 access from the
comfort and privacy of your own home or office.

= Your health & online
Pre-Register wellness platform

Download the FM healow app!

£ Available on the . Mvailable on
@ App Store JPSREREEIEEN
. ; Find us using our unigue EDFCAA

practice code on the healow app

Appointments Request Refills View Health Records
from your doctor

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.



MuU: Maximize Use of Portal Messages
from Patients to Coordinate Care

"Have patients send you Blood Sugar or BP or
other Logs (manually entered)

mRespond to Patient to adjust care

"Update Med Dosing in RX Screen of Web
Encounter

AssignedTo

Nutesl Addendum | Log History | ¥irtual ¥isi
Browse
AM 105562 PM 99771

7 arM 101/62 PM 110760
7723 6:00 AM 113565 F:aM 121763

Action Taken

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Mu: Customize Portal Message Workflow to
Maximize Use of Portal by Patients

"Turn on Item Key so patients can “Reply”
to Web Encounters & Portal Messages

"|mproves efficiency - Avoids callbacks if patients need
further clarification or want to provide confirmation

="Not overused by patients - usually only get replies that
would have been phoned in to staff or sent via a new
portal message (and a few thank-you’s)

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




vu: Portal Message “Replies”

mRecognized by “RE:” in
Reason

"Original Message
appears in “Message”

box below new message
"Boosts MU Stage 2 Score B
for Secure Electronic
g Mlessaging by patients

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Advocate the Portal & Healow
Not Just for the Benefit of Your Office,
but for the Benefit of Your Patients

Reason

AssignedTo
|thanl-c you

|v| |BI|:||:I-c:, EBradley M ﬂ

Nutesl Addendum] Log Histuryl Virtual ‘Jisitl

Addressed To: Dr. Block

Thank you
are ready. Amazing... v

v Perform Eligibility Check
M355393| Rx lLahstIl

for tour fast response. I just got a call from CWS. My scripts

Action Taken Reply to patient Action Taken ||| Check 51

Reason

AssignedTo

||:|Iac.5|1,rJ the iPhone access is awesume*vl IE-I::n:L:, Bradley M j

[T Perform Eligibility Check
HESSEH_II'El Rx |Lah5,,|l’DI|

Nutesl Addendum | Log Histurv_.rl ¥irtual 'ln'isitl

Message Complaints ||| Browse
See, this is one of the reasans I really like this practice. Up 2 date with technology, processes,
procedures, medicines, and general knowledge about new diagnostic technigues and treatments!

fwesome that we patients can finally see what the doc *really* said instead of what we thought we
heard!

Just wanted to give big kudo's to the decision makers,

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Web Enabled Stats
for Patients Seen in Past 2 Years

Dr Block’s own Patients = 92%

Dr Bigg's own Patients = 89%
Dr Block’s Family Medicine Group = 88%
Dr Bigg’'s Multi-Specialty Group = 78%
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Paperwork & Information Sharing
in the Past

gt
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Paperwork & Information Sharing
in the Office of Today

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Customize Paperwork
& Charting Protocols

-un with Forms
Rattle your Records

Rush through
Reports K

f
;Paperless{

Al A
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New eClini-Ideas for eCliniForms

eCliniFarms

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Create Custom eCliniForms —
Digitally Ink Standardlzed Forms as Needed

3 Ink document. Pages - 1/1

®Create Standardized
Forms with Provider
Info pre-filled in:
=Procedure Consents,

Disabled Parking, Specialty

Pharm Forms, Diabetes Ed

Referrals, Insulin Sliding

Scales, Release of Records, —

M/C ABN L ,.Jﬂ*“’ T W

=Ink, Print & Save On
Demand

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Improve eCliniForm Efficiency & Accuracy -
Automatically Insert Patient Name & DOB

(need to be sure Item Key turned on)

&, Ink document. Pages - 1/1

Save To Attach To| | MuliPage | g .00 cpe
L || patient - e

i, Ink document. Pages - 1/1

Save To Attach To L ~| Multi-Page
Local \.% patient L-_]J | Inking Bubble Sheet

BLOCK & NATION, P.A.
FAMILY PRACTICE

Bradley M. Block, M.D.
Craig P. Chase, M.D. Susan G. Sm|

PROCEDURE CONSENT FORM

Eﬁti,ent Name: Test,Adiel DOB: 08/11/1955 ﬁl
— uvate Of Froceaure

Paticnt Name

Procedure Shave Biopsy (Biopsies)

STATEMENT OF REQUEST

1 The nature and purpose of the procedure, possible alternative methods of treatment, the risks in
possibility of complications have been fully explained to me. | understand that the reason for the
performed by the Doctor is for: cancer screening and / or removal of irritated skin lesion(s)

| have also been made aware that there are other possible risks such as pain, loss of blood, infe
recurrence of this same problem that are attendant on the performance of surgical procedures o

understand that the practice of medicine and surgery is not an exact science and thus | acknowlg

have been made to me concerning the successful results of this procedure. The Deoctar has info
following nisks and consequences are also associated with this procedure:

eClinicalWorks

eClinicalWorks

A. Notifier: BLOCK, NATION, CHAS
2441 W. SR 426 STE 2011 O

Patient Name: Demo,Patient DOB: 05/20/1969 |Acq
B/ Patient Name: C

Advance Beneficiary Notice

NOTE: If Medicare doesn't pay for D.

Medicare does not pay for everything, even some ca
good reason to think you need. We expect Medicare

ITEM/SERVICE

Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Use Topaz type Signature Device to
Automatically Insert Patient Signature into
eCliniForm Signature Box

i, Ink document. Pages - 1,1

Save To Attach To | |, Multi-Page
Local \.& R =) H Inking Bubble Sheet

H Addltlonal Intormatlon Zapkure signakure from signa
This notice gives our opinion, not an official Medicare deq
this notice or Medicare billing, call 1-800-MEDICARE (1-800-

Signing below means that you have received and understand

L Signature:

Accordimg e the Paperwork Reduction Act of THIS. nuo persons are reguired Lo t'c.»[mn.d w a collecto

This notice gives our opinion, not an official Medicare dle
thls notlce or Medicare billing, call 1-800-MEDICARE (1-80(
at you have received and understant

According G the Paperwork Reduction Act of THYS. no persons arce reg ired te ['C}.[‘H}I'I.d w i colleet
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Use “Update” Function in eCliniForms to
Customize Location of Data Inserted by eCW

"Use “Patient Info Loc”
X-Y Axis to imprint
patient name at desired
location on forms

"Use “Signature” X-Y
Axis for Signature
Device to insert
patient’s signature at
desired location on
forms

Sighature " (1314
Patiert Info Loz = Im—
Patient Info Loz v I E3

Block, M.D. -- William “Reddy” Biggs, M.D.




Tips for eCliniForm X-Y Axis Location

=sX=Horizontal Axis,
Y=Vertical Axis

"Higher #s move Location
farther to Right & to
Bottom of page

=Quickly estimate X-Y Axis
location with Microsoft
Paint (included in Windows:
All Programs> “Accessories”)
or just use trial & error

" ocate Axis to allow
enough space for long

SEINES

‘ (J COMPREHENSIVE DIABETES SELF-MANAGEMENT EDUCATION |
AND MEDICAL NUTRITION THERAPY =

= || FL HOSP DIABETES EDUCATION ORDER 2013 001 - Paint

Phone: {407)303-2822, option #3
Diabetes Education Order

Patient Name: X

Diagnosis: ] Type 2 Diabetes (O Type 1 Diabetes OIGT
Other pertinent diagnosis

Current Diabetes Medications (Type/Dose/Frequency):

Patient now uses: [] Pen [ Vial/Syringe [ Pump:
Complete the following lab information or attach copy of curre

AlC: Date of A1C: BP: C &e e
Please check if patient needs instruction in : D sPANISH [

.
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While on Topic of Customizing
Documents....
Avoid Stereotypical EMR & Consult Notes!

| THRERW A WERSH ERN THE WERLL DERN'T ERSK MAH, ER'LL NERVER
TERLL | LERKERD TO E ERS ERT FERLL ERND NERW ER ERN MAH WER |
TRERDE MAH SERL FER A WERSH PERMNERS ERND DERMAHS FER A
KERSS | WERSN'T LERKERNG FER THERS BERT NERW ER ERN MAH WER
ER STERE WERS HERLDERN' RERPPERD JERNS, SKERN WERS SHERWERN'
HERT NERGHT, WERND WERS BLERWNERN' WHERE E THERNK ER GERNG
BERBER? HER, | JERST MAHT E ERND THERS ERS CRERZER BERT HERER'S
MAH NERMBER SO CERLL MAH, MAHBER ERT'S HERD TO LERK RERGHT
ERT E BERBER BERT HERE MAH NERMBER SO CERLL MAH, MAHBER HER, |
JERST MAHT E ERND THERS ERS CRERZER BERT HERER'S MAH NERMBER
S0 CERLL MAH, MAHBER ERND ERLL THE ERTHER BERS TRER TO CHERSE
MAH BERT HERER'S MAH NERMBER SO CERLL MAH, MAHBER E TERK ER
TERME WERTH THE CERLL | TERK NO TERME WERTH THE FERLL E GERVE
ME NERTHERNG ERT ERLL BERT STERLL, ER ERN MAH WER | BERG ERND
FERLLERW ERND STERL HERVE FERERSERGHT ERND ERT'S RERL |
DERDN'T KNERW | WERLD FERL ERT BERT ERT'S ERN MAH WER ER STERE
WERS HERLDERN' RERPPERD JERNS, SKERN WERS SHERWERN' HERT
NERGHT, WERND WERS BLERWNERN' WHERE E THERNK ER GERNG
BERBER? HER, | JERST MAHT E ERND THERS ERS CRERZER BERT HERER'S

ERT E BERBER BERT HERE MAH NERMBER SO CERLL MAH, MAHBER HER, |
JERST MAHT E ERND THERS ERS CRERZER BERT HERER'S MAH NERMBER
SO CERLL MAH, MAHBER ERND ERLL THE ERTHER BERS TRER TO CHERSE
VIAH BERT HERER'S MAH NERMBER S0 CERLL MAH, MAHBER BERFERE E
CERME ERNTO MAH LERFER | MAHSSERD E 80O BERD | MAHSSERD E SO
BERD | MAHSSERD E SER, SO BERD BERFERE E CERME ERNTO MAH
LERFER | MAHSSERD E SO BERD ERND E SHERLD KMNERW THERT I
MAHSSERD E SER, 80 BERD ERT'S HERD TO LERK RERGHT ERT E BERBER
BERT HERER'S MAH MERMBER SO CERLL MAH, MAHBER HE | JERST MAHT]
E ERND THERS CRERZER BERT HERER'S MAH NERMBER SO CERLL MAH,
MAHBER ERND ERLL THE ERTHER BERS TRER TO CHERSE MAH BERT
HERER'S MAH NERMBER SO CERLL MAH, MAHBER BERFERE E CERME
ERNTO MAH LERFER | MAHSSERD E SO BERD | MAHSSERD E SO BERD |
MAHSSERD E SER, SO BERD BERFERE E CERME ERNTO MAH LERFER |
MAHSSERD E SO BERD ERND E SHERLD KMERW THERT SO CERLL MAH,
MAHBER
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— Customize Your Visit Notes —
Make Important Items

Physical Examination: %
GEMERAL

General appearance nontoxic, in no acute distress and has obvious L UE paresis w/ swelling

contractures.
PSYCH
mental status alert & oriented X 3. mental status alert & oriented X 3. Mood euthymic,
normal. Mood euthymic, normal. Affect appropriate. Affect appropriate. appearance grooming & clothi
appropriate. appearance grooming & clothing all appropriate. cognition Within normal limits. cognition

normal limits. Eye contact normal.
HEENT

oropharynx normal. mouth poor dentition. ear canals normal. tympanic membranes normal. scle

anicteric. pupils ERRRLA. EOM intact.
NECK

neck supple. thyroid not enlarged. cervical lymph nodes normal. ROM normal. supraclavicular

recesses without mass or adenopathy.
HEART

PMI normal. rate regular, w/o ectopic beats. heart sounds normal. murmurs II/VI, III/VI, systd

murmur, apex, lower left sternal border, upper left sternal border, upper right sternal border. clicks
CHEST

shape and expansion normal. breath sounds normal, without consolidation

changes. rales no. wheezes no. rhonchi no.
ABDOMEN

shape normal. guarding no. tenderness no. masses no. liver, spleen not palpable. hernia absen

tenderness no.
EXTREMITIES

tremors no. erythema no. clubbing no. cyanosis no. edema Left UE & Left LE mild and diffuse.
NEUROLOGICAL

overall Right UE normal, but has major deficits & Paresis & very limited functional use in Left
partially reduced in B/L lower extremities. Cranial Nerves II to XII intact.

eClinicalWorks

eClinicalWorks

Physical Examination: %
GEMERAL

General appearance nontoxic, in no acute distress and has obvious L UE paresis w/ swelling
contractures.
PSYCH
mental status alert & oriented X 3. mental status alert & oriented X 3. Mood euthymic,
normal. Mood euthymic, normal. Affect appropriate. Affect appropriate. appearance grooming & clothing 3
appropriate. appearance grooming & clothing all appropriate. cognition Within normal limits. cognition Wi

normal limits. Eye contact normal.
HEENT

oropharynx normal. mouth poor dentition. ear canals normal. tympanic membranes normal. sclera

anicteric. pupils ERRRLA. EOM intact.
MNECK

neck supple. thyroid not enlarged. cervical lymph nodes normal. ROM normal. supraclavicular

recesses without mass or adenopathy.
HEART
PMI normal. rate regular, w/o ectopic beats. heart sounds normal. murmurs II/VI, II1/VI, systolid
ejection murmur, apex, lower left sternal border, upper left sternal border, upper right sternal
border. clicks no.
CHEST
shape and expansion normal. breath sounds normal, without consolidation

changes. rales no. wheezes no. rhonchi no.
ABDOMEN

shape normal. guarding no. tenderness no. masses no. liver, spleen not palpable. hernia absent. rg

tenderness no.
EXTREMITIES

tremors no. erythema no. clubbing no. cyanosis no. edema Left UE & Left LE mild and diffuse.
NEUROLOGICAL

overall Right UE normal, but has major deficits & Paresis & very limited functional use in L
and partially reduced in B/L lower extremities. Cranial Nerves II to XII intact.
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Try Using:
Bold — Underline — Color Options

=\Works in HPI, ROS, Exam & PE

= Automate process by pre-configuring these in Pic List
Customization screens & in Templates

mj.e.—Set Abnormal Findings to be bold or in color
=" To Modify on the fly - nghllght Sentences & Hit Button

i Physical Exam Notes E . HPI Notes

Free-form [ Structure Free-form

_ Options for chest pain Delimiter I l
Options For murmurs 2elim ] 3

lheaviness, aggravated with ise or exertio erity: moderate,
s ymptom duration for over several hours at a time, symptoms felt
101 UL p i y constantly, Not Associated with:, 3 OB, Diaphoresis, Radiation of
L Tl s ymptoms
> MnUrTmL

Duration I I [~ Days [~ Morths [~ Years

Location/R adiation

I:n_m'un-g
dy:

Cugtarn
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Customize Your Faxes Too

m. Fax Preview Assessments

o : From . Preoperative Examination, Unspecified - V72.84
| [FefPhysicie =] Bramss | e [Block Bradiey M. M.D. (Primary), Within Normal Limits and Medically

To Fax I - | Provider: IBradIey Black,
CCFax i J Browse Voice # Cle for S ge
B = I B E7EH
I IHEF Physiciz |4D? 6785358 2. Hypertension, Benign - 401.1
Subject: IPHE OF PE Compary: IBIock,Natlnn,Ehase,Smolen Familyt ed 3 Hypothyroidism, Unspecified - 244.9, onset 2015
1. Insomnia/MNonorganic Skeep Disorder, Unspe g07.40, chronie

COmpany: Faility: IBIock,Natinn,Chase,Smolen Fa EBrowse... 5. GERD - Gastroesophageal Reflux, No Esophag
I . Il vitreous - 379.24
[f = 5 Arial -l Sizes - . Hyperlipidemia - <
£ D @[ B 7 U ]= 1;' L l J; ﬁ Fasental hypertrig) idemia 1
- Anzmia, iron deficiency, other, specified - 2808, all 2° to malahsorption from high dase PP1TX , 8/P Normal Specialist
VorkUp, Resolved
Degenerativ thri 21,90, Lumbar & Cervieal DMD

1. Preﬂ el‘ative Exalllil]atioll U]_]S eciﬁed - " ]-':bmm\_m]gja Myalgia/ Myositis, Unspecified - 729.1, much improved on on SSRITX

Assessments

Tiy pertension, Benign - 401.1 Patient: . ln]()n;: s Progress Note: Bradley M. Block,

Hypothyroidism, Unspecified - 244.9, onset 2015 Nate generated by eClinicaMiorks ‘EMF'.?FI:M Suﬂwa?u fwww.eClinicalWorks.com)

Insomnia/Nonorganic Sleep Disorder, Unspecified - 307 .40, chronie

GERD - Gastroesophageal Reflux, No Esophagitis - 530.81

Floater, vitreous - 379.24

Hyperlipidemia - 272.4 . . . )

Essental hypertriglyceridemia - 272.1 http://192.168.20.117:8080/mobiledoc/jsp/catalog/xml/GetFaxHTMLDoc.jsp?logid=114269  9/15/20135

Anemia, iron deficiency, other, specified - 280.8, all 2" to malabsorption from high dose PPI

TX, §/P Normal Specialist WorkUp, Resolved

10. Degenerative spinal arthritis - 721.90, Lumbar & Cervical VD

11. Fibromyalgia/Myalgia/ Myositis, Unspecified - 729.1, much improved on on 5581 TX -
i

® 0 men 0 =)

Summary View fo Page 6 of 8

ES/DM labs:, Normal and Cptimal, Anemia: & Iron Levels: WHL & good Hgh now But iron harely normal, BF: at Goal.
~hignature  Clear I Update

Treatment
. Preoperative Examination, Unspecified

IMAGI :
EKG NSR, WNL

Notes :NSR or mild Sinus Bradyecardia, Equivocal/Borderline ST& T
wave changes present but nothing that appears significant, No Acute
ST/Tw changes, No Reciproeal Changes, No Significant Changes

[~ Schedule &8 print |a Print Preview | Copy | Send Fax | Cancel | I ShowHide Panels versus old EKG done 2/17/2009 , and Patient had a Normal Nuclear
Stress Test in 8/2007, and No Ectopy Block Bradley M, M.D. 09/15/2015 0420128 PM
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Leap Through Labs & Documents
Like Never Before

lm

Labs/Tmaging

Review Documents
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v10: Cruise Through Your Incoming Lab
Results Faster Than Ever

Value Reference Range
5.1 3.7-8.6 mg/dL

t patient=s: <&.0
Assigned to:

[ Block, Bradiey M =

L 478 .
- ba, 5610 W LaSalle Street, Tampa, FL 336071770, Phons - 8008775227, Director Result:

C, 2500 Sumner Bhd, Ralkeigh, NC 276163235, Phone - 8775476837, Director - |Nc-rrna|

- Imv Status:
By Visit | ™ Open * Reviewed
By Patient (Unreviewed) [
By Patient (All) I High Priority
I Don't publish to Web Portal

Order Date: 2014-03-05 _ T .
Time: 10:33:00 - imestamp rowse...

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




v10: View Patient Documents
in a New Light

Progress Notes Progress Notes
MName |GI 09/2014 DR SHULTZ Options
[~ Reviewed

. Revi dD d Lab
Browse | Time Stamp W E=T=E rHEhE L

™ High Priority

Description b )
Assigned To

Block, Bradley M hd
Tag |

Facility
N FACSIMILE TRANSMITTAL FORM
Scanned By | ORTIZ, WANDA j Scanned Date | 8/29/2014  « ~

At To Patient
Attached To | E‘

Date/Time:  9127/2014 7:40:56 PM
[~ Make this as document name

Pages: 3

Subject: Progress Notes

To: Bradley Block

Fax Number: 407-678-0252
FACSIMILE TRANSMITTAL FORM

From: Shultz,Robert A

Date/Time: 8/2712014 7:40:66 PM Fax Number: 407-359-8630

Pages: 3 Business Phone:  407-476-0882

- C : Gasty teral

Subject: Progress Notes ompany: s f_s_:f_D_ﬁ_ﬂl 'fg logy

MNOTE: PLEASE CALL 407-478-0882 IF DOCUMEMNTS ARE INCOMPLETE
OR NOT LEGIBLE.

To: Bradley Block

Fax Number: 407-678-0252

The information contained in the facsimile message may be confidential andfor legally

privileged information only for the use of the individual of entity named above.
Progress Notes Progress Notes

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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v10: Patient Document Logs - New Option

for Tracking Who “Reviewed” Them
- No Need to Time Stamp Anymore

|| Options

I~ Reviewed
[~ Reviewed Doc and Lab

rowse | Time Stamp [ High Priority

Description ’—“ -
Assigned To
Bl , Bradley M

Tee [ Facility
Scanned By | ORTIZ, WANDA Scanned Date | 9 /29/2014 = :| |!|

: — T
Attached To |_| .

[~ Make this as document name |.IEE_||| ||

ROWEM:

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Encrypt Medical Record CD’s
for Full-Proof HIPAA Compliance

sAdobe’s Password Protection Not Same as Encryption
=Use AES 128 Bit Encryption Key

'Try Roxio Creator (special version w/ encryption) "E‘“ -
or free “PDFilliPDESoaies FOFi FREE

PDF Tools

®Create Standardized Password Protocol

" (i.e.- use limited list of passwords or last 4 digits of SS#)

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Billing & Finances of the Past

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Contemporary Billing & Finances

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Maximize Efficiency - Interface with
Collection Agency - TransWorld Systems

Look Up By |Co||ec:ti0n Cycle Mame Filter ,_ to ,_
Collection Cycle |C3 Balance ’—LI ’T Ex Status 'm
Collection Rule  [Apply J I all 5] Lookup

: N: arantor Name | Hq C - Balal |current Cycle] Recent Activity | Status | External Status
81656 : Final $79.30 on 01/29/2014 @ sTART
73514 158.00 Final $30.00 on 04/23/2014 @ START
83844 100,00 Final $30.00 on 05/16/2014 @ START

94180 Test, test Test, test 508-329-3337 0.00 Final

Add Patient Payment

Patient Account Inquiry

Print Patient Statement

Print ePatient Statement

Remove From Collection

Move T Different Cellection Cycle

Upload START File Te TransWorld Collection Agency
Upload STOP File To TransWorld Collection Agency Records: 5, Page Balance: $561.70

25 1-5 v|of Srecords  Generate Letters | v Generate Collection Details For Selected Patients J

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.
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Collection Agency Interface
Automatically Creates Billing Alerts

3 Billing Alert for ( TEST, COLE-FAKE )

[ BllllngAlert | Global Alerts Insurance Alert |
[ Show Billing Alert

Given to collection on: 10/14/2014

Current collection status: C3

Billing Motes  TimeStamp | Check Spelling

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Take Home Message

=Customize Your Workflow in eCW to \
Optimize & Maximize Your Efficiency,
Documentation & Patient Care

"|mprove Patient Engagement & Satisfaction
=Save on Staffing Costs & Boost Income

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Your Assignment & Thoughts for
Moving Your Practice Forward

mRefer to your notes & Implement the 3-5 Ideas
sShare wisdom throughout your group
= Try to develop on-site Super User(s)

"Choose some |leaders to participate in the eCW
Web User’s Forum: http://www.ecwusers.com/

*"EMR, PM, MU, ICD10, Portal, IT, eClinicalTouch...

USErs
nacy2

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




Questions?

"Bradley M. Block, M.D.
=\William “Reddy” Biggs, M.D.

=For copy of our current & past presentations
& Dr Bigg’s Pharmacy Fax Letter go to:
http://blockandnation.com/blockandbiggs

eClinicalWorks Bradley M. Block, M.D. -- William “Reddy” Biggs, M.D.




